
Contents

Beta 2.5 Release Notes

Release Notes

What is "Beta" Software?

Feedback

Introduction

Introduction

Release Notes and Comments

Learning HTML

Uninstalling HomeSite

Windows NT

About the Author

Technical Support

Using HomeSite

Toolbars

Spell Checker

Publishing

Directory Pane

Projects

HTML Help

Open from the Web

Style Sheets

Right-click Tag Editing

Thumbnail Viewer

Verifying Links

Settings and Preferences

Editing

Browsing

Additional Features

Keyboard Shortcuts

Technical Information

HomeSite Common Questions



Common Questions

Ordering HomeSite

How to Order

Registering on CompuServe

Registering on the World Wide Web

1-800 Registration

Registering by Mail



Release Notes

For details on additions, fixes, changes and known problems, please read the HISTORY.RTF document 
installed with the beta.

For more information about this beta, please stop by the HomeSite 2.5 beta site at 
http://www.dexnet.com/homesite/beta/.



What is "Beta" Software?

Beta software is "pre-release" software - it is not the final release. The purpose of beta testing is to 
uncover bugs and receive feedback that will help ensure that the final release is a solid product. As with 
all beta software, you will most likely encounter bugs in this beta of HomeSite 2.5. If you're not 
comfortable with this, I encourage you to use the release version of HomeSite 2.0 instead. 



Feedback

If while using this beta you discover a bug that isn't listed on the beta Questions page, please drop me a 
line at nick@dexnet.com. Just include the phrase "Beta 2.5 bug" in the subject line, and also let me know 
the following information: 

 

· A complete description of the problem and steps to reproduce it 

· The operating system you're using (Windows 95 or NT4), plus any service packs you've installed 

· Whether the problem always occurred with the beta or it appeared just recently. •If the problem 
appeared just recently, what software you installed between the time the program worked fine and the 
time you noticed the problem 

 

There is also a HomeSite Open Discussion Forum that includes a Beta 2.5 Section - feel free to post your 
comments here, and make any suggestions for features you'd like to see. Please understand, however, 
that this forum is not a means to obtain technical support from Bradbury Software (which is only available 
to registered users).    While I do monitor this forum, it is meant solely as an open discussion forum for 
HomeSite users. 



Introduction

      Welcome to Bradbury Software's HomeSite 2.5, the most powerful - and most affordable - 
HTML editor available for Windows 95 and NT 4.0.    Here are a few help pointers to get you started:

· Learning HTML

· Editing and browsing 

· Customizable tag coloring

· Right-click tag editing

· Drag-and-drop image and anchor tag creation

· Settings and preferences

· HTML spell checker

· Project Management

· Verifying Links

· Saved style sheets

· Toolbars

· Custom toolbars

· Keyboard shortcuts

· Common questions

· Ordering HomeSite



Release Notes and Comments

Please read the document HISTORY.RTF for information concerning changes since the last release.



Learning HTML

HomeSite is designed for those comfortable with HTML - if you're looking for a    WYSIWYG environment 
that hides the HTML syntax, HomeSite is probably not for you.    There are a number of good WYSIWIG 
authoring tools, such as Microsoft's FrontPage and Netscape's Navigator Gold, that you may find more 
suitable. 

However, to really learn HTML, you should roll up your sleeves and stick to an editor like HomeSite.    If 
you're brand new to HTML, you might want to check out some of these on-line resources before 
proceeding:
A Beginner's Guide to HTML http://www.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimer.html

Introduction to HTML http://members.aol.com/htmlguru/about_html.html

HTML Quick Reference http://kuhttp.cc.ukans.edu/lynx_help/HTML_quick.html

Microsoft Internet Explorer 
3.0 HTML Reference

http://www.microsoft.com/workshop/author/newhtml/default.htm

HTML Reference Manual http://www.sandia.gov/sci_compute/html_ref.html

Uninstalling HomeSite

Uninstalling HomeSite is a simple process - just go into Control Panel, double-click on 'Add/Remove 
Programs,' then double-click on 'HomeSite.' 

Important: Because HomeSite stores custom button information in the registry, uninstalling HomeSite will 
remove all custom button information.    If you are simply upgrading HomeSite from an earlier version and 
wish to retain the custom buttons, just install the new version over the current one without uninstalling.



Windows NT

HomeSite is compatible with Windows NT 4.0 - in fact, HomeSite was developed on an NT 4.0 
workstation - but a few cosmetic problems have been found under NT 3.51.    It is recommended that you 
run HomeSite only under Windows 95 or NT 4.0.



About the Author

The author is a recluse who doesn't have too much to say about himself.    He is, however, also a 
cartoonist, and as such isn't above a little shameless self-promotion...

So, if you're a comic strip fan, or just in need of a laugh, stop by http://www.dexnet.com/dexter.html for 
your weekly dose of Dexter.

Note: Some cartoons may be inappropriate for small children or small-minded senators.    'Nuff said.



Technical Support

If you have a question that isn't answered in the Common Questions, or if you have a bug to report, stop 
by the HomeSite "Support" page at http://www.dexnet.com/homesite/hs_faq.html for up-to-date 
information about HomeSite and solutions to common problems. 

Note: Technical support is only available to registered users!    Please understand that due to the volume 
of mail I receive, I cannot answer messages sent by unregistered users.



Toolbars
Main Toolbar

The HTML Speedbar

QuickTab Toolbar

Fonts Toolbar

Tables, Frames and Lists Toolbars

Tag List

Other Toolbar

JavaScript Toolbar

ASP ("Denali") Toolbar

Apps Toolbar

Custom Toolbar

Special Characters



Main Toolbar

Apart from the standard toolbuttons (cut, copy, paste, open, save, undo, etc.), the main toolbar contains 
the following:

Displays the Project dialog

Checks the spelling in the current 
document

Publishes the current document 
(requires Microsoft's Web 
Publishing Wizard)

Displays the Settings dialog

Verifies links in the current 
document Switches to full screen display mode

Displays the find dialog

Toggles word wrap in the current 
document

Displays the replace dialog

Toggles the display of the Directory 
Pane

Displays the extended replace 
dialog

Browses the current document using 
your external browser

The HTML Speedbar

The HTML Speedbar is a series of toolbars that provide quick access to the most common HTML tags. 

These toolbars can be hidden through the SpeedBar in the Settings dialog.



QuickTab Toolbar

The QuickTab toolbar displays the most frequently used HTML tags, such as bold and center, for easy 
access.    In addition, the QuickTab toolbar provides the following functions:

Displays the QuickStart dialog

Displays the QuickBody dialog

Displays the QuickAnchor dialog

Displays the QuickImage dialog

Displays the QuickRule dialog



Fonts Toolbar

The Fonts toolbar displays common font tags that aren't already on the QuickTab toolbar, such as 
heading styles.



Tables, Frames and Lists Toolbars

The Tables, Frames and Lists toolbars contains several buttons related (oddly enough)    to tables, 
frames and lists.      These toolbars also provides the following features:

Displays the Table Wizard

Displays the QuickTable sizer

Displays the QuickList dialog

Displays the Frame Wizard



Tag List

The tag list displays a dropdown list of HTML tags.    Tags are inserted into the current document by 
clicking the toolbutton to the right of the list.



Other Toolbar

As its name implies, the other toolbar contains items such as Forms and ActiveX controls that aren't 
available in other toolbars.    Many of these items are specific to either Microsoft Internet Explorer or 
Netscape Navigator and are noted so in the toolbutton tooltips. 

In addition, any dialog used to create Netscape- or Microsoft-specific features will display the icon of the 
appropriate browser.



JavaScript Toolbar

The JavaScript toolbar contains 
items related to creating JavaScript 
code, including a drop-down tree of 
JavaScript objects (shown at left).

This toolbar also contains the 
JavaScript Wizard, which was 
designed to make it easy to take 
advantage on common JavaScript 
functionality such as menus and 
scrolling text.

ASP ("Denali") Toolbar

This toolbar contains shortcuts for creating Active Server Pages, which were introduced in Microsoft 
Internet Information Server 3.0.



Apps Toolbar

The Apps toolbar lets you quickly access other applications that you may use during web page 
development.    To add or remove applications from this toolbar, click the configure button to display the 
dialog below:

Note that the Command Line allows you to pass the name of the current document.    This can be 
extremely useful when using applications such as the CSE 3310 HTML Validator, which accepts the 
filename of a document to validate.
Just to get you started, here's the URLs of a few applications that I've found useful when creating web 
pages:

Name URL
CSE 3310 HTML Validator http://www.flash.net/~wiersch/htmlvalidator.html

MapThis! http://galadriel.ecaetc.ohio-state.edu/tc/mt/

GIF Construction Set http://www.mindworkshop.com/alchemy/gifcon.html

PaintShop Pro http://www.jasc.com/

HTML Reference Library http://subnet.virtual-pc.com/~le387818/

WS_FTP95 http://www.csra.net/junodj/ws_ftp32.htm

Custom Toolbar



The custom toolbar (toggled with the 
<F4> key) displays six buttons 
containing customizable menus.

To configure the menu for each 
button, just click the "Customize…" 
selection.    Each menu item can be 
configured to insert a specific start 
and end tag, or to insert the contents 
of a file, at the current cursor 
position.

Note:    You can type anything into the Start Tag and End Tag fields, including tabs and line returns.    In 
other words, you're not limited to just using HTML tags - in fact, you can place entire HTML documents or 
scripts here if you wish. 



Special Characters

HomeSite also has a tabbed toolbar containing the most common Special Characters (also known as 
Extended Characters).    To display this toolbar, simply select "Special Characters" from the "View" 
menu.



Spell Checker

HomeSite includes a built-in spell checker to help you find your spelling mistakes.    While this spell-
checker was designed to act like the one in Microsoft Word, it does have one very powerful difference: 
HomeSite's spell checker can be configured to skip all text within HTML tags.    To use this feature, simply 
go to the General page of the Settings dialog, and place a check in the option labeled "Skip tags when 
spell checking."    If you've ever used an HTML editor with a spell-checker that keeps flagging HTML tags 
and file names, you'll really appreciate this feature!



Publishing

If you have Microsoft's Web Publishing Wizard on your system, you can easily upload your documents 
directly from HomeSite.

To upload the current document, just click the Publish button  on the main toolbar.    To upload a 
group of documents, select the documents in the file list, right-click, and select Publish from the popup 
menu.

Note: The Web Publishing Wizard is a separate product from HomeSite.    Please refer to Microsoft for 
technical support or information on downloading the Publishing Wizard.



Directory Pane

The directory pane gives you quick access to all your HTML documents and web graphics.    To open a 
document in the edit or browse windows, just double click on it.    Or to insert an <A> or <IMG> tag, just 
drag-and-drop a file to the desired insertion point.    You can even drag-and-drop sound and animation 
files into the editor.

Right-clicking on a document displays the document options menu.    This menu allows you to copy, 
rename or delete (via the recycle bin) an HTML document.    It also allows you to display a document's 
properties, including a list of all external links.    In addition, choosing 'Edit' when an image or multimedia 
file is selected will open that file in its associated application. 

 
You can filter which files get displayed in this list by 
making a selection from the file filter combo.    By 
default, Web documents are files with the extension 
HTM, HTML, SHTM, SHTML and CSS, but you can 
easily change this.    Just go into Settings, and on the 
"Files" page add or delete from the list of Document 
Extensions.

Note: The file types displayed in the document list can be modified through HomeSite's settings dialog.    
If you regularly use extensions such as CGI or TXT, for example, this is where you would add them so 
that they appear in the document list.

Above the file list is an 
"Explorer"-style view that shows 
your drives and directories.    
Although not as full-featured as 
Explorer, you can still drag-and-
drop folders into each other and 
create/rename folders.    You can 
also move files to different 
folders by drag-and-dropping 
them from the filelist

More:
Document Properties



Document Properties

The document properties dialog, which is accessed by right-clicking on a document in the Directory 
Pane and selecting "properties," gives you easy access to a document's title, creation date and last 
modified date.    In addition, the properties dialog provides a list of all the external links that are contained 
in the selected document.    The "Dependencies" page displays a list of all images and other 
dependencies in a document.

Selecting "Properties" for an image file displays a dialog containing a preview of that image, along with 
details about the image.





Projects

HomeSite enables you to maintain groups of HTML documents through an easy-to-use project dialog. 

To create a project, simply click 'New Project,' and then add HTML documents to the project by clicking 
the 'Add File' button.    Once you have all your HTML documents selected, click 'Save Project' and give 
the project a name.    The project will then appear in the project list to the left.
To open a project, simply click the 'Open Project' button or double-click on the project in the list.    Opening 
a project will open every document it contains.    Once you open a project, the QuickAnchor dialog will 
contain relative paths to each document in the project.    This makes it easy to add hyperlinks to other 
documents in the project.

Another powerful project-oriented feature is the ability to search-and-replace across an entire project.    
HomeSite's Extended Search-and-Replace enables you to select a project and replace entire blocks of 
text in every document the project contains.

Note:    Each project is stored in an individual file in the \Projects subdirectory.    Whenever a project is 
changed, a backup is automatically created.    These project files are merely pointers to your HTML 
documents - the documents are not moved or modified in any way.



HTML Help

HomeSite includes a built-in HTML reference to make editing HTML as painless as possible.    Any time 
you're in doubt about the HTML tag you're editing, just hit <F2> and help for that tag will be displayed.

Important:    HomeSite's internal HTML help feature requires Microsoft Internet Explorer 3.01 or later.

If you'd prefer to use a different HTML help reference,    just go into Settings, and switch to the tab titled 
"Files."    At the top of this tab is an HTML help section:

Just select the "Use this external HTML help file" option, and click the browse button to select the external 
help file. Once the external help file has been added, you can get context-sensitive help while editing 
simply by pressing F2.
This feature has been tested with both    Stephen Le Hunte's excellent HTML Reference Library 
(http://subnet.virtual-pc.com/~le387818) and Microsoft's HTML help file 
(http://www.microsoft.com/workshop/author/newhtml/default.htm).



Open from the Web

HomeSite enables you to open HTML files directly from the World Wide Web.    Simply choose Open 
from Web from the File menu, type the URL of the file you wish to retrieve, and HomeSite will download it 
into a new document.    If you use Microsoft Internet Explorer, HomeSite will display a "Favorites" button, 
enabling you to select the URL from your Favorites folder.    In addition, Netscape users can select the 
URL from their Bookmarks list.

Note: Before retrieving a remote file, you may have to first log on to the Internet.



Style Sheets

HomeSite enables you to take advantage of the Style Sheet features introduced in Microsoft Internet 
Explorer 3.0.    You can easily create and save your own styles and apply them with minimal effort.

The Styles toolbar (shown below) maintains a list of all your saved styles.    To apply a style to a block of 
text, simply select the text, highlight the style you want to apply, and click the down arrow button to the 
right of the list.

To create or modify styles, click the    button to display the Saved Styles dialog.



Right-click Tag Editing

One of HomeSite's most useful additions is its right-click 
tag editing feature.    Whereas most HTML editors act as 
though you'll never edit your HTML after you write it, 
HomeSite assumes that you will make changes - 
probably dozens of them - before you're done working 
on a document.    Rather than re-enter or modify your 
HTML tags, just place the cursor in the tag and right-
click.    HomeSite will display a popup menu which 
includes an Edit Tag entry for the current tag.    Select 
this entry, and the tag will be displayed in the appropriate 
dialog.    This is an enormous time-saver.

This feature currently supports the following tags:

<A> <HR>

<BASEFONT> <IMG>

<BGSOUND> <MARQUEE>

<BODY> <META>

<!-- -- > <P>

<EMBED> <PARAMETER>

<FONT> <SCRIPT>

<FRAME> <TABLE>

<FRAMESET> <TR>

<IFRAME> <TH>

<TD>

Thumbnail Viewer

HomeSite includes a built-in image thumbnail viewer to make adding graphics to your HTML as simple as 
possible.    Just right-click on the filelist and select "View Thumbnails," and a dialog containing every 
image in the current directory will be displayed.    You can then right-click on any image to insert an 
<IMG> tag at the current cursor location.





Verifying Links

Due to the transitory nature of most Web pages, you'll undoubtedly find that many of the sites you link to 
will move (or be removed) during the lifetime of your site.    Tracking down these "missing links" can be 
time-consuming, but HomeSite makes the job easier by letting you know which links might be bad.

More:
Setting the Root URL for Relative Links

Verifying Links

Modifying Links



Setting the Root URL for Relative Links

 The Verify Links button on the main toolbar will test the validity of the links in the current document. 
After clicking this toolbutton, the first thing you'll see is the Set Root URL dialog (below).

Use this dialog to specify how HomeSite should process relative links.    For example, from one page on 
my site I may link to another page on my site using the relative link <A 
HREF="homesite/download.html">.    When verifying links, I'll need to specify which URL to use to 
complete these relative links (which, in my case, would be http://www.dexnet.com/).    After entering the 
root URL, you can check the "Default to this URL" setting to always start the link verification with the 
selected root URL.

Note: Setting the root URL will not modify your document in any way - it's simply used to tell HomeSite 
how to test relative links.

Once the root URL has been set, you're ready to start verifying links.



Verifying Links

After selecting the root URL, you'll see the main link verification window.    This window contains a list of 
all the links in your document, and also includes dependencies such as images.    By default, all the links 
will be checked, but you can uncheck as many links as you like to skip verifying them.    This "link list" is 
split into three columns.    The first column simply displays the link as it appears in your HTML document, 
while the second column displays the link as a complete URL using the root URL you specified.    The 
third column displays the verification status of the link, which will be "untested" for all links when you first 
open the window.

 If the    Show HTML Source toolbutton is down, the bottom of this window will display the source for 
the actual document in a read-only textbox.    From the link list, you can select any link and link will be 
highlighted in the source - if the link appears multiple times in the document, all instances of the link will 
be highlighted, and a count will appear in the status bar.

 If you need to change the root URL to use for relative links, you can do so without exiting the 
window.    This will update the Full URL column in the link list.

 You may also want to change the Timeout setting, which is the number of seconds to wait for a 
response when testing a link before giving up.    The default setting is 30 seconds. 

 The real purpose of this window is accessed by clicking the Verify All Links button.    Once this is 
pressed, HomeSite will go down the link list and verify every link and dependency it finds, with the 
following exceptions:

· Links to secure pages (HTTPS)

· FTP links (this is expected to be added in a future release)

· "mailto:" links



If a link is verified, a small "verified" icon  will be displayed next to it.    A separate icon 
 is used to denote timeouts.    If for any reason a link fails, a failure icon 

 will appear next to it.    The failure message retrieved from the HTTP server will be displayed in the 
result column in the link list - usually this message is similar to "HTTP/1.0 Not Found," which simply 
means that the document couldn't be located.    In most cases, you can simply ignore this message and 
assume that the link is no longer valid.

 You can test individual links by selecting the Verify Current Link button.    This is handy if you 
modified a link and what to retest it without testing other links.



Modifying Links

 After the verification is complete, you can use the Modify Current Link button to change failed links. 
Any changes are saved in memory until you click the save button - in other words, no changes are made 
to the actual HTML document until you press the save button. 
When you choose to modify a link, all instances of the modified link will be replaced - so if a link to 
"http://www.dexnet.com/" appears three times, all three links will be updated.

IMPORTANT: HomeSite's modify link feature will only replace links that are surrounded in quotes within 
your HTML source.    If you use unquoted links in your documents (such as <A 
HREF=http://www.dexnet/com>, this function will not work for you.    Instead, you'll have to update 

the links in HomeSite's normal editing window after the link verification process is completed.



Settings and Preferences
General Preferences

Files

Editor

Internal Browser

External Browser

SpeedBar



General Preferences

The General Preferences page contains these items:

Auto-fill HEIGHT and WIDTH for <IMG> tags

Force filenames to lowercase for <IMG> and <A> tags

Lowercase all inserted tags

Show splash screen on startup

Always insert colors as hexadecimal values

Skip tags when spell checking

Show only file names in the file list

Always save using UNIX format

Use Microsoft instead of Netscape format for multimedia

Confirm drag-and-drop file operations



Files

On this page you may specify the name of an HTML file to use as a template when creating new 
documents.    Anytime a new document is created, the contents of the selected file will be inserted into the 
editor.

The File Types page also contains options allowing you to specify which file extensions denote HTML 
documents.    Files containing any of these extensions will appear in the directory pane's file list.    In 
addition, you may specify the default extension to use when saving HTML documents.

At the bottom of this page is the location of the external HTML help file to use with HomeSite.



Editor

The Editor page is where you specify how you'd like tags to appear when Color Coding is turned on.      
The font selected in the first frame is used for all text, but individual colors and styles (bold, italic, etc.) can 
be applied to different tags.    When color coding is set to minimal, all tags are colored using the 'Other 
Tags' settings.

You may also modify the editor's tab width on this page (the default is 20).



Internal Browser

By default, HomeSite uses its own HTML 2.0 browser.    This default browser doesn't support newer 
HTML additions such as frames and style sheets.    However, if you have Microsoft Internet Explorer 
(MSIE) version 3.01 or higher on your system, you can change this so that HomeSite uses MSIE instead. 
Just check the "Use Internet Explorer" checkbox, and an embedded copy of MSIE will be used inside of 
HomeSite.

Important:    for this to work correctly, make sure you're running Internet Explorer 3.01 or higher.    If you 
use the original MSIE 3.0, you may experience resizing problems.

If you would prefer to use different fonts and colors in HomeSite's default internal browser, this is where 
you can change them.



External Browser

This page is where you specify the external browser(s) to use when the browse button on the main 
toolbar is pressed.    If more than one browser is specified, then selecting the browse button will display a 
menu containing all the specified browsers.

When launching an external browser, you have the following options:
Prompt to save If the document about to be browsed has 

been modified, you will be prompted to save 
changes.

Automatically save If the document about to be browsed has 
been modified, it will automatically be saved.

Use temporary file HomeSite will save the current document, 
including changes, as a temporary file.    This 
enables you to experiment with your changes 
without having to save them.    The downside 
to this is that any links back to the original 
document will load the original document 
rather than the temporary one.

 



SpeedBar

This page allows you to specify which toolbars to display with the HTML Speedbar.    If you're short on 
screen space, or if you find that you don't use some of the toolbars, you can hide them here.



Editing

HomeSite lets you easily edit and browse HTML documents by switching between the "Edit" and 
"Browse" pages in the main window.

When in edit mode, everything you type is color coded when you move off an edited line (provided color 
coding is turned on, off course).    This lets you easily pick out mistakes and formatting problems.    The 
editor contains a number of options which are easily accessed by right-clicking.    The most powerful of 
these options is the Edit Tag option, which enabled you to easily edit pre-existing tags with minimal 
typing.

When multiple documents are open, HomeSite displays a set of tabs at the bottom of the editor showing 
each open document.    You can move between these tabs either by clicking on them with the mouse or 
using the keyboard shortcuts Ctrl+Tab and Shift+Ctrl+Tab.    If changes have been made to the 
document since the last time it was saved, the tab will have a red marker on it.

If a block of text is highlighted, the Selection submenu on this popup will be enabled, which contains 
powerful formatting features that allow you to convert the selection to a list or table or to strip tags from 
the selection.

HomeSite also supports block indenting, so you can click  or 

 to indent or un-indent entire blocks of text.

More:
Document Color Coding

Searching and Replacing

Creating a Document from a Template



Document Color Coding 

HomeSite supports color coding of HTML tags, which makes editing documents much easier than with 
simple text editors. Color coding may be changed by selecting 'Color Coding' from the 'Options' menu.

There are three levels of color coding:

None Display all text in black, as in standard text editors such 
as Notepad.

Minimal Apply color coding to all tags (i.e.: text between '<' and 
'>'), using the font defined for 'All Other    Tags.'

Full Apply color coding to all tags, using different font styles 
and colors for specific tags.

Note: On slower machines, or when editing larger documents, it is recommended that you set color 
coding to 'None.'

The font styles used when color coding are completely customizable.    For example, if you prefer to show 
table-related tags in bold, or you want comments displayed in italics, you can easily change HomeSite's 
font settings.    Just go to the options dialog and change the font settings to suit your tastes.



Searching and Replacing

HomeSite contains powerful search and replace features that ease the maintenance headaches 
associated with web authoring.    Besides the simple find and replace functions (which are self-
explanatory), HomeSite contains an extended replace feature that allows you to find and replace text in 
entire directories or projects.    And unlike most replace operations, extended replace isn't limited to 
simple words or phrases - you can replace entire blocks of text, if desired.

If you choose to replace in a particular folder, so can also choose to replace in all subfolders beneath the 
selected folder by placing a check in the box labeled "Recurse subdirectories." 

When performing a replace involving multiple files - especially when recursing subdirectories - it is 
strongly recommended that you check the "Make Backups" option so that backups of all the files being 
searched will be made.    The backups will have the same name as the original files plus the extension 
'.bak.'

IMPORTANT:    The extended replace function does not confirm each replacement - once you click 
'Replace All' and confirm your action, you will not be warned before each replace operation!



Creating a Document from a Template

By clicking the "New" toolbutton, a new document is created based on the default template defined in 
HomeSite's settings.    However, if you select "New" from the "File" menu (or press CTRL+N), HomeSite 
will display a list of available templates from which to create your new document.    If you find that many of 
your HTML documents are based upon similar layouts, consider creating a template from the layout.



Browsing

One of the most useful features in HomeSite is its ability to let you view (or browse) your HTML 
document as it will appear to web visitors. 

Although HomeSite's default internal browser doesn't support more recent HTML features (such as 
frames and style sheets), if you use Microsoft Internet Explorer 3.01 or later, you can easily overcome this 
limitation.    Just go into HomeSite's settings, and on the Internal Browser page place a checkmark in the 
item shown below:

This will replace HomeSite's default internal browser with an embedded copy of Microsoft Internet 
Explorer.

Note:    The feature requires Internet Explorer 3.01 or later - you may encounter resizing problem with the 
original 3.0 release.

In addition to the internal browser, HomeSite also enables you to maintain a list of external browsers.    
Just go into the External Browser page of HomeSite's settings to define this list.

    This button on the main toolbar is used to display the current page in the external browser.    If more 
than one external browser has been specified, a menu will appear allowing you to choose which browser 
to preview with.    If only one browser has been specified, clicking this button will open it directly without 
displaying a menu. 



Additional Features
Full Screen

Rulers

Tag List



Full Screen

Full Screen mode expands the HTML editor and browser to fill the entire screen.    To switch back 
to normal size, hit the <Esc> key, or right-click in the editing window and uncheck the "Full Screen" menu 
option.



Rulers

HomeSite contains a set of rulers marked with the standard screen sizes (640x480, 800x600, 
1024x768).    These rulers can be useful in determining whether your layout will fit a certain screen 
resolution.      You can toggle the rulers by selecting "Rulers" from the "View" menu.

Note: The rulers serve only as a rough estimate of actual display size.    Since different browsers have 
their own display peculiarities, and since users can often customize a browser's fonts, it is advisable to 
test your pages in different browsers rather than rely solely on the rulers.



Tag List

The Tag List (which is also accessible from the "button displays a floating dialog containing a list of HTML 
tags and attributes.    To insert an item from the list into the current document, simply double-click on it.



Keyboard Shortcuts
Shortcut Action
ALT+X Close HomeSite

CTRL+A Select All

CTRL+B Bold

CTRL+C Copy

CTRL+E Tag selection

CTRL+F Find

CTRL+G Go to line

CTRL+ I Italic

CTRL+K Re-apply color coding

CTRL+L Toggle color bar

CTRL+N New document

CTRL+O Open an HTML document

CTRL+R Replace

CTRL+S Save changes to the current document

CTRL+T Show/hide main toolbar

CTRL+U Underline

CTRL+V Paste

CTRL+W Close the current document

CTRL+X Cut

CTRL+Y Delete the current line

CTRL+Z Undo the last edit

CTRL+ > Insert an empty end tag (</>)

CTRL+ < Insert an empty start tag (<>)

CTRL+% Inserts empty ASP ("Denali") tags (<% %>)

CTRL+TAB Next document

F1 Help

F2 External HTML Help

F4 Custom toolbar

F7 Spell check

F8 Settings

F9 Toggles the document list

F10 Full Screen

F11 View in external browser

F12 Toggle between edit/browse mode

SHIFT+CTRL+Spac
e

Non-breaking space (&nbsp;)

SHIFT+ CTRL+ - Font Size - 1

SHIFT+ CTRL+ = Font Size + 1

SHIFT+ CTRL+ 1..6 Heading 1..6

SHIFT+ CTRL+ A Quick Anchor

SHIFT+ CTRL+ B Break

SHIFT+ CTRL+ C Comment Editor

CTRL+SHIFT+E Special characters



SHIFT+ CTRL+ F Quick Font

SHIFT+ CTRL+ H Horizontal Rule Editor

SHIFT+ CTRL+ I Quick Image

SHIFT+ CTRL+ L List Editor

SHIFT+ CTRL+ P Paragraph

SHIFT+ CTRL+ Q Quick Start

SHIFT+CTRL+S Save As

SHIFT+CTRL+ T Table Editor

SHIFT+CTRL+ U Save as Unix

SHIFT+ CTRL+ W Frame Wizard

SHIFT+CTRL+ > Indent block

SHIFT+CTRL+ < Un-indent block

Technical Information
File List

Registry Settings



File List

The following files are installed by HomeSite:

File Name Description
HomeSite.exe Main executable

HomeSite.hlp Help file

HomeSite.cnt Help contents

Sky32v3c.dll Image viewer library

Custom.dct Custom dictionary

HomeSite.dct HomeSite dictionary

ASP.dat Items for ASP dropdown

Attributes.dat Attribute list

Tags.dat Tag list

Tips.dat Tips

History.rtf HomeSite release history

license.rtf HomeSite license

Order.txt Order information

Templates\Default Template.hst Default template

Templates\Glossary of Terms.hst Glossary template

Templates\Table of Contents.hst Table of contents template

In addition to these files, HomeSite also creates "Projects," "Templates" and "Thumbnail" subdirectories 
off of the main application directory.



Registry Settings

HKEY_CURRENT_USER\Software\HomeSite

String Value Description
AutoFillImageSize -1 = true, 0 = false

AutoIndent -1 = true, 0 = false

CloseParagraphTags -1 = true, 0 = false (add </P>

ColorBar -1 = true, 0 = false (show color bar)

CurrentTip Number of the last HomeSite tip viewed

EMailAddress Last e-mail address entered in the e-mail dialog

ExternalHTMLHelp Name and location of external HTML help file

ForceHexColor -1 = true, 0 = false (use hex values for colors)

InitialDir Startup directory

LowercaseFiles -1 = true, 0 = false (lowercase <A> and <IMG> file 
references)

LowercaseTags -1 = true, 0 = false (lowercase all inserted tags)

MultimediaFormat 0 = Microsoft, 1 = Netscape

ProjectDir Location of project files

Rulers -1 = true, 0 = false (show rulers)

SaveAsUnix -1 = true, 0 = false

ShowSplash -1 = true, 0 = false

ShowTips -1 = true, 0 = false

TemplateDir Location of templates

Timeout timeout (in seconds) for "Open from Web"

WordWrap -1 = true, 0 = false

Additional settings are stored in the following subkeys:

Subkey Description
AppBar1 Configuration information for the "Apps" toolbar

ColorCoding Color coding font information

Custom1-5 Custom button information

DocumentList Properties related to HomeSite's document list

ExternalBrowser
s

External browser configuration information

HTMLExtensions File extensions that denote HTML documents

InternalBrowser Internal browser configuration information

MainForm Size and location of the main form

MRUDocuments Most recently used documents

ProjectList Column widths for the project dialog

ShowAgainMsg Information pertaining to the "Don't show this message again" 
dialogs

SpeedBar Visible toolbars in the speedbar

TagForm Size and location of the tag form

Toolbars Toolbar information

URLHistory Most recently used URLs from the Anchor dialog

Common Questions



Some of the toolbuttons are cut off

Some of the toolbuttons show up as blank white squares

How do I report a bug?

Will HomeSite run on NT 3.51?

Will there be a version for Windows 3.x, OS/2 or Mac computers?

How do I add a link to another file?

Adding a link to a file changes the filename to lowercase.

Several copies of MSIE are loaded when I use it as my external browser

My frames show up in MSIE, but not in Netscape

HomeSite was unable to create the Microsoft Internet Explorer (MSIE) object

I'm using MSIE as HomeSite's internal browser, and it doesn't resize correctly

When I use MSIE as the internal browser, it asks me to save the file to disk

Associating HomeSite with HTML files doesn't work

Opening large documents in HomeSite takes several seconds

Scanning a large directory in HomeSite takes several seconds

How do I define different extensions for HTML documents?

Other sources for answers to common questions



Some of the toolbuttons are cut off

This may happen when running HomeSite at a low resolution.    The easiest way to free up screen space 
is to select "Toolbar Layout" from the "Options" menu, and choose a Horizontal toolbar layout.    In 
addition, you can hide the main toolbar, speedbar, color bar and status bar to free up even more space.    
Each of the toolbars that make up the speedbar can also be hidden - just right click on any of the toolbars 
and select 'Show/Hide Toolbars.'    And to really make the most of space, switch to full screen mode.



Some of the toolbuttons show up as blank white squares 

This problem has only been reported on systems with Diamond video cards.    If you're experiencing this 
problem, make sure you have the latest drivers for your video card.    You can also correct the problem by 
turning down the hardware acceleration (to do this in Windows 95, right-click on "My Computer" and 
switch to the "Performance" page for graphics settings).



How do I report a bug?

If you find a bug in HomeSite, before reporting it please stop by the HomeSite buglist at 
http://www.dexnet.com/homesite/hs_buglist.html to see if it has already been reported.    This page will be 
updated regularly.



Will HomeSite run on NT 3.51? 

Due to a number of cosmetic problems running under NT 3.51, HomeSite is not officially supported on 
that platform.    HomeSite runs great on NT 4, though.



Will there be a version for Windows 3.x, OS/2 or Mac 
computers?

Sorry - there are no plans for any versions of HomeSite for operating systems other than Windows 95 and 
NT 4.



How do I add a link to another file?

The easiest way to create an anchor tag is to simply drag-and-drop a file from the filelist.    This will create 
an <A> tag with the relative path to the file filled in for you.    The other way is to simply click on the anchor 
button on the toolbar.



Adding a link to a file changes the filename to lowercase.

Go into "Settings," and on the "General" page uncheck the box    labeled "Force filenames to lowercase 
for <IMG> and <A> tags."    Once this is unchecked, HomeSite will insert filenames as they really appear.



Several copies of MSIE are loaded when I use it as my 
external browser

This problem can be circumvented by making MSIE your default browser and unchecking the "Use DDE" 
option    in HomeSite's external browser settings. 

To make MSIE your default browser, select 'Options' from MSIE's 'View' menu, then switch to the 
'Programs' page.    At the bottom of this page is an option to force MSIE to check whether it's the default 
browser.



My frames show up in MSIE, but not in Netscape

 Make sure your frames don't come after the <BODY> tag - when used with frames, the <BODY> tag 
should only appear in the <NOFRAMES> section.



HomeSite was unable to create the Microsoft Internet 
Explorer (MSIE) object

This error message will appear if Microsoft Internet Explorer has been defined as HomeSite's internal 
browser, but the MSIE object could not be created.    For this option to work, you must have Microsoft 
Internet Explorer 3.0 or higher, and it is recommended that you use MSIE 3.01 or higher.    If you're sure 
you're already using MSIE 3.0 or higher, before contacting tech support please stop by the HomeSite 
"Question and Answer" page at http://www.dexnet.com/homesite/hs_faq.html for up-to-date information 
about this and other issues. 

This error message may also occur if MSIE isn't your default browser.



I'm using MSIE as HomeSite's internal browser, and it doesn't 
resize correctly

The original MSIE 3.0 may not resize properly inside of HomeSite.    The only fix for this is to download 
and install MSIE 3.01 or higher.



When I use MSIE as the internal browser, it asks me to save 
the file to disk

This will occur if Internet Explorer isn't your default browser - for MSIE to work inside of HomeSite, it must 
be your default browser.    To make it your default browser, select 'Options' from MSIE's 'View' menu, then 
switch to the 'Programs' page.    At the bottom of this page is an option to force MSIE to check whether it's 
the default browser.



Associating HomeSite with HTML files doesn't work

For the association to work, select "Options" from Explorer's    "View" menu, and switch to the "File Types" 
page.    Double-click on the HTML file type in the "List of Registered Files," and then double-click on the 
"Action" associated with HomeSite. All you need to do is add "%1" (including the quotes) to the end of this 
entry, i.e.: C:\HTML\HomeSite.exe "%1" And also make sure that "Use DDE" is unchecked.

 



Opening large documents in HomeSite takes several 
seconds

To speed up loading of large documents, turn off HomeSite's color coding.



Scanning a large directory in HomeSite takes several 
seconds

HomeSite's filelist scans directories using a separate thread, so you can continue editing while it 
populates.    However, for extremely large directories or directories on remote servers, this process may 
take several seconds.    You can speed this up by setting the "Show only file names in the filelist" option 
on the "General" page in HomeSite's settings.    This will prevent HomeSite from scanning each HTML 
document for it's <TITLE> and each image for it's dimensions.      You can also completely disable the 
filelist by right-clicking on it and selecting "Disable."



How do I define different extensions for HTML documents?

You can customize which files appear in the document list as HTML documents by going into settings and 
switching to the 'Files' page.    Just click the 'Add' button at the bottom of the page to add a new extension



Other sources for answers to common questions

If you don't find the answer to your question here, make sure to stop by the HomeSite FAQ page at 
http://www.dexnet.com/homesite/hs_faq.html.      This page will be updated regularly with answers to the 
most common questions.



How to Order

HomeSite is "WebWare" - it is only available by downloading it. After you register HomeSite, you will be e-
mailed a user name and registration number to "un-nag" it. Because HomeSite is distributed in this 
manner, the cost of packaging (which you'll just throw out anyway) isn't added to the cost of the software. 
This also means that you don't pay the "hidden" cost of distribution. 

IMPORTANT!    Make sure to include a valid e-mail address with your order.    If you don't supply an e-
mail address, or the e-mail address you supply is invalid, your registration information cannot be sent to 
you!

There are several registration methods available:

Registering on CompuServe

Registering on the World Wide Web

Registering by Phone

Registering by Mail

 

Please refer to the chart below when ordering: 

  

License Price CompuServe SWREG#
Single License $39.95 12981

Five Licenses $159.95 12995

Ten Licenses $299.95 12996

Fifty Licenses $999.95 12997

Site license CONTACT ME

Registering on CompuServe

CompuServe users may register HomeSite in the Shareware Registration forum (GO SWREG). Please 
refer to the chart on the How to Order page for SWREG numbers. 

If you register on CompuServe, there's no need to supply an e-mail address - your order will automatically 
use your CompuServe address.



Registering on the World Wide Web

HomeSite may be registered by secure form on the WWW - just stop by the HomeSite registration page 
at http://www.dexnet.com/homesite/hs_register.html for details!



1-800 Registration

Credit card orders by telephone are handled at (800) 599-8856. Just tell them you'd like to order 
HomeSite, and be sure to give them your e-mail address! 

Note: This toll-free number belongs to an independent registration agency - they only handle 
registrations. If you need technical support, please stop by http://www.dexnet.com/homesite.html instead! 



Registering by Mail

For those of you who prefer to use snail mail, payment by check    or money order (sorry - US currency 
only!) may be sent directly to me at:

 
Bradbury Software, LLC
1423 North Nash Street
Suite 2
Arlington, VA 22209 

 
Please note that I cannot accept credit card orders at this time.

IMPORTANT:    Make sure to include your e-mail address with your order!    If your order doesn't include 
an e-mail address, it will be delayed until I can track you down!



configure button.



By default, when images are selected during the creation of an <IMG> tag, HomeSite will automatically fill 
in the HEIGHT and WIDTH of the image.



By default, HomeSite adds the names of selected files exactly as they appear.    Since many pages are 
hosted on case-sensitive UNIX systems, however, you may wish to always insert the filenames as lower 
case.



By default, HomeSite inserts tags in uppercase.    Check this option to change this.



By default, HomeSite displays a "splash screen" on startup.    Check this option to stop the splash screen 
from displaying.



By default, HomeSite will insert color names whenever a named color is selected.    However, many older 
browsers don't recognize these named colors, and only use hexadecimal values.    Check this item to 
force HomeSite to always insert colors as hex values.



By default, HomeSite will check the spelling of all HTML tags along with normal text.    Set this option if 
you would prefer that HomeSite skips HTML tags and only checks normal text.



By default, HomeSite includes detail information (such as a document's title or an image's dimensions) in 
the file list.    If you regularly work with large or remote directories, check this option to list only the name 
of the file.    This will boost performance.



By default, HomeSite saves HTML documents in standard PC format.    However, if you'd prefer to always 
save using UNIX format, then check this item.    PC format uses both a carriage return and a line feed at 
the end of each line of text, whereas UNIX format uses only a line feed.



By default, HomeSite will insert a <BGSOUND> tag for sound files, and an <IMG DYNSRC> tag for 
animation files. These tags are, however, specific to Microsoft Internet Explorer.    You can change this 
behavior so that HomeSite uses Netscape's <EMBED> tag instead.



HomeSite's "Explorer"-style interface enables you to easily drag-and-drop files between folders, and even 
drag-and-drop folders into other folders.    By default, you will always be asked to confirm these actions, 
but you can turn off confirmations with this setting.




